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CHƯƠNG I : KHÁI NIỆM VỀ HỆ CƠ SỞ DỮ LIỆU 

BÀI 1 :MỘT SỐ KHÁI NIỆM CƠ BẢN 
 
 

1. Bài toán quản lí: 

Bài toán quản lí học sinh trong trường THPT. 

Để quản lý học sinh trong nhà trường, người ta thường lập các Bảng gồm các cột, hàng để chứa các 

thông tin cần quản lí. 

Stt Họ tên Ngày sinh 
Giới 

tính 

Đoàn 

viên 
Địa chỉ 

Điểm 

Toán 

Điểm 

Lý 
... 

Điểm 

Hóa 

Điểm 

Văn 

Điểm 

Tin 

1 Nguyễn An 12/8/1991 Nam C Nghĩa Tân 7,8 8,2 ... 9,2 7,3 8,5 

2 Trần Văn Giang 21/3/1990 Nam K Cầu Giấy 5,6 6,7 ... 7,7 7,8 8,3 

3 Lê Minh Châu 3/5/1991 Nữ C Mai Dịch 9,3 8,5 ... 8,4 6,7 9,1 

4 Doãn Thu Cúc 14/2/1990 Nữ K Trung Kinh 6,5 7,0 ... 9,1 6,7 8,6 

... ... ... ... ... ... ... ... ... ... ... ... 

50 Hồ Minh Hải 30/7/1991 Nam C Nghĩa Tân 7,0 6,8 ... 6,5 6,5 7,8 

Hình 1. Ví dụ hồ sơ học sinh  

-  Xét bài toán quản lí học sinh trong trường THPT.Hãy chỉ ra các yếu tố tạo nên hoạt động quản lí 

này qua các câu hỏi sau: 

a. Ai quản lí  

o Hiệu trưởng, BGH, học vụ, GVCN, GVBM, giám thị.       

b. Quản lí cái gì?  

o Quản lí thông tin chi tiết của học sinh toàn trường.  

c. Quản lí vì cái gì? (Mục đích) 

o Quản lí việc học tập và rèn luyện của học sinh 

d. Quản lí trong hoàn cảnh nào? (Điều kiện và môi trường quản lí) 

o Trình độ học sinh đầu vào ra sao? Cơ sở vật chất thế nào? 

e. Cụ thể thông tin chi tiết về học sinh là những thông tin gì?  

o Thông tin về học sinh gồm: lý lịch của học sinh; kết qủa học tập và rèn luyện của học sinh.  

f. Để quản lí điểm có cần lưu tên môn học đó không? Tại sao?    

o Để quản lí điểm của học sinh nhất thiết ta phải ghi tên môn học nhằm đáp ứng nhu cầu tìm 

kiếm, thống kê theotừng môn học. 

g. Nêu những công việc thường gặp trong quản lý học sinh ở cuối kì hoặc cuối năm học? 

o Sắp xếp học sinh theo thứ tự ĐTB của cả học kì để xếp loại 

o Thống kê, tổng hợp như đếm số đoàn viên, số HS đạt loại giỏi, tính điểm trung bình... 

2. Các công việc thường gặp khi xử lí thông tin của một tổ chức: 

a) Tạo lập hồ sơ: 

- Bước 1: 

Xác định chủ thể cần quản lý. VD ở mục 1: .............................................................................  

Xác định các thông tin liên quan đến chủ thể mà ta cần quản lí. VD: .......................................  

- Bước 2: Xác định cấu trúc hồ sơ  

VD ở mục 1 sử dụng cấu trúc dạng bảng vì tối ưu, thuận lợi nhất trong quản lí. 

- Bước 3: Thu thập, tập hợp thông tin cho hồ sơ từ nhiều nguồn khác nhau và lưu trữ chúng 

đúng cấu trúc đã xác định. 

b) Cập nhật hồ sơ (thêm, xóa, sửa hồ sơ). 

c) Khai thác hồ sơ (sắp xếp, tìm kiếm, thống kê, lập báo cáo, lập kế hoạch và ra quyết định ...) 

→Các bước trên là các công việc cần làm khi giải bài toán quản lý 
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- Vậy các công việc này chúng ta sẽ sử dụng công cụ gì để thực hiện? 

- Hãy so sánh công việc quản lí giữa thời xa xưa chưa có ngành tin học với thời hiện tại bây giờ? 

Thời xa xưa Thời hiện tại 

Dùng giấy, viết, con người để xử lí các công 

việc này. 

Khuyết điểm 

Hồ sơ lưu trữ chiếm diện tích lớn. 

Con người sẽ đảm nhận xử lí thông tin, do đó 

chậm và dễ sai sót. 

Vd:Tìm kiếm, thống kê sẽ tốn rất nhiều thời 

gian. 

Dùng máy tính và con người. 

Ưu điểm 

Lưu được một lượng lớn thông tin trong 

một không gian nhỏ. 

Máy tính xử lí thay cho con người do đó 

việc xử lí nhanh và độ chính xác cao. 

3. Hệ cơ sở dữ liệu: 

a) Khái niệm CSDL: 

❖ Dữ liệu là gì? (Nhắc lại khái niệm đã học ở lớp 10) 

− Là các thông tin của đối tượng (người, vật, một khái niệm, sự việc…) được lưu trữ trên máy 

tính. 

− Dữ liệu được mô tả dưới nhiều dạng khác nhau (các ký tự, ký số, hình ảnh, ký hiệu, âm 

thanh…). Mỗi cách mô tả gắn với một ngữ nghĩa nào đó. 

− Dữ liệu về đối tượng có thể khác nhau, tùy thuộc vào ngữ cảnh. Ví dụ: dữ liệu về đối tượng 

sinh viên có thể khác nhau tùy vào mục đích quản lý: 

− Quản lý điểm: Tên, mã sinh viên, điểm môn 1, điểm môn 2, điểm môn 3 

− Quản lý lý lịch: Tên, địa chỉ, ngày sinh, quê quán, lớp 

❖ Cơ sở dữ liệu là gì? 

• CSDL là tập hợp các dữ liệu có liên quan với nhau về hoạt dộng của một tổ chức, được lưu 

trữ ở thiết bị nhớ ngoài và có nhiều người cùng khai thác. 

• Hệ CSDL gồm hai thành phần : CSDL và hệ QTCSDL. 

 

Ví dụ: Một cuốn danh bạ được tin học hoá thành cơ sở dữ liệu máy tính. Với CSDL này người dùng 

không chỉ có thể tìm kiếm số điện thoại mà còn tìm kiếm được địa chỉ, tên người. 

 

Hiện nay, cơ sở dữ liệu có mặt trong tất cả các lĩnh vực chẳng hạn: 

− Ngân hàng: giao dịch. 

− Hàng không: đặt vé, lịch trình. 

− Trường học: đăng ký, điểm. 

− Bán hàng: danh sách khách hàng, danh mục sản phẩm. 

− Sản xuất: bản ghi kho, đơn đặt hàng, dây chuyền cung ứng. 

− Nhân sự: hồ sơ nhân sự, bảng lương, khấu trừ thuế. 

− Y tế: phiếu khám sức khỏe, tình trạng sức khỏe của bệnh nhân, ... 

❖ Quản lý dữ liệu bằng cách nào? 

✓ Hệ thống quản lý bằng file 

− Dữ liệu được lưu trữ trong các file riêng biệt như Word, Excel,… 

− Nhược điểm của việc quản lý bằng file: 

• Dư thừa và mâu thuẫn dữ liệu 

• Kém hiệu quả trong truy xuất ngẫu nhiên hoặc xử lý đồng thời 

• Dữ liệu lưu trữ rời rạc 

• Gặp vấn đề về an toàn và bảo mật 

✓ Hệ thống quản lý bằng CSDL:  

− Quản lý dữ liệu bằng CSDL giúp dữ liệu được lưu trữ một cách hiệu quả và có tổ chức, cho 

phép quản lý dữ liệu nhanh chóng và hiệu quả. 

− Lợi ích của hệ thống quản lý bằng CSDL: 
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• Tránh dư thừa, trùng lặp dữ liệu 

• Đảm bảo sự nhất quán trong CSDL 

• Các dữ liệu lưu trữ có thể được chia sẻ 

• Có thể thiết lập các chuẩn trên dữ liệu 

• Duy trì tính toàn vẹn dữ liệu 

• Đảm bảo bảo mật dữ liệu 

→ Khi giải quyết các bài toán trên máy tính thì người ta phải xây dựng cơ sở dữ liệu và xây dựng 

thuật toán xử lý chúng. Khi cơ sở dữ liệu càng lớn nhu cầu xử lý phức tạp, yêu cầu bảo mật càng cao 

thì vấn đề quản trị cơ sở dữ liệu càng phức tạp. 

❖ Những vấn đề mà CSDL cần phải giải quyết: 

− Tính chủ quyền của dữ liệu: 

• Thể hiện ở phương diện an toàn dữ liệu. 

• Khả năng biểu diễn mối liên hệ ngữ nghĩa của dữ liệu và tính chính xác của dữ liệu. 

• Người khai thác cơ sở dữ liệu phải cập nhật cho CSDL những thông tin mới nhất. 

− Tính bảo mật và quyền khai thác thông tin của người sử dụng: 

• Do ưu điểm CSDL có thể cho nhiều người khai thác đồng thời nên cần phải có một cơ 

chế bảo mật phân quyền khai thác CSDL. 

• Các hệ điều hành nhiều người sử dụng hay cục bộ đều cung cấp cơ chế này. 

− Tranh chấp dữ liệu: 

• Khi nhiều người cùng truy nhập CSDL với các mục đích khác nhau. Rất có thể sẽ xảy ra 

hiện tượng tranh chấp dữ liệu. 

• Cần có cơ chế ưu tiên khi truy cập CSDL. Ví dụ: admin luôn có thể truy cập cơ sở dữ liệu. 

• Cấp quyền ưu tiên cho từng người khai thác. 

− Đảm bảo an toàn dữ liệu khi có sự cố: 

• Khi CSDL nhiều và được quản lý tập trung. Khả năng rủi ro mất dữ liệu rất cao. Các nguyên 

nhân chính là mất điện đột ngột hoặc hỏng thiết bị lưu trữ. 

• Hiện tại có một số hệ điều hành đã có cơ chế tự động sao lưu ổ cứng và fix lỗi khi có sự cố 

xảy ra. 

b) Hệ quản trị CSDL: 

❖ Hệ Quản Trị Cơ Sở Dữ Liệu là gì? 

− Hệ QTCSDL(Database Management System - DBMS)  là phần mềm cung cấp một 

môi trường thuận lợi và hiệu quả để tạo lập, lưu trữ và khai thác hiệu quả CSDL. 

− Các hệ quản trị cơ sở dữ liệu phổ biến hiện nay bao gồm: Microsoft Access, Oracle, 

MySQL, PostgreSQL, SQL Server... 

❖ Hệ CSDL gồm hai thành phần : CSDL và hệ QTCSDL. 

  

http://tinhoccoban.blogspot.com/2015/09/gioi-thieu-ve-he-quan-tri-co-so-du-lieu.html
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BÀI 2: HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU 
 

1. Các chức năng của hệ quản trị cơ sở dữ liệu : 

a. Cung cấp môi trường tạo lập CSDL: 

 

 

 

b. Cung cấp môi trường cập nhật dữ liệu, tìm kiếm và kết xuất thông tin: 

 

 

 

 

 

- Ngôn ngữ định nghĩa dữ liệu + Ngôn ngữ thao tác dữ liệu →ngôn ngữ CSDL. 

- Ngôn ngữ CSDL được sử dụng phổ biến hiện nay là SQL (Structured Query Language - 

ngôn ngữ hỏi có cấu trúc) 
 

c. Cung cấp công cụ kiểm soát, điều khiển việc truy cập vào CSDL: 

- Đảm bảoan ninh,  ngăn ngừa truy cậpkhông được phép. 

- Duy trì tính nhất quáncủa dữ liệu 

- Tổ chức điều khiển các truy cập đồng thời 

- Đảm bảo khôi phục CSDL khi có sự cố ở phần cứng hay phần mềm 

- Quản lí các mô tả dữ liệu. 

2. Vai trò của con người khi làm việc với hệ cơ sở dữ liệu: 

a) Người quản trị CSDL.    

- Quản lí các tài nguyên của CSDL, hệ QTCSDL. 

- Bảo trì hệ CSDL 

- Nâng cấp hệ CSDL: Bổ sung, sửa đổi để cải tiến chế độ khai thác, nâng cao hiệu quả sử dụng. 

- Tổ chức hệ thống: Cấp phát quyền truy cập cho người dùng, đảm bảo an ninh cho hệ CSDL. 

b) Người lập trình ứng dụng: 

- Khi CSDL đã được cài đặt, người lập trình ứng dụng tiến hành xây dựng chương trình ứng 

dựng để đáp ứng nhu cầu khai thác của người dùng. 

c) Người dùng: 

- Thường được phân thành từng nhóm, mỗi nhóm có một số quyền hạn nhất định để truy cập 

và khai thác CSDL. 

3. Các bước xây dựng CSDL 

- Bước 1 :Khảo sát 

- Bước 2 :Thiết kế 

- Bước 3 :Kiểm thử 

BT: Có 4 công việc  

+ Tìm hiểu bài toán: Xác định có đối tượng nào, thông tin nào cần quản lí, các nhiệm vụ của bài 

toán. 

+ Tìm hiểu thực tế: Tìm hiểu các tài liệu, hồ sơ, chứng từ, sổ sách liên quan. 

+ Xác định dữ liệu: Xác định các đặc điểm của dữ liệu, các ràng buộc dữ liệu. 

+ Tổ chức dữ liệu theo cấu trúc đảm bảo các ràng buộc (tạo cấu trúc dữ liệu) 

Hãy sắp xếp các công việc trên thành quy trình hợp lí khi tạo hồ sơ cho bài toán quản lí. 

Khai báo kiểu DL, cấu trúc DL và các ràng buộc trên 

DL 

Sử dụng ngôn ngữ định nghĩa dữ liệu  

Cập nhật: (Nhập,sửa, xoá dữ liệu) 

 

Khai thác: Sắp xếp, tìm kiếm, thống kê, kết xuất báo 

cáo,... 

Sử dụng ngôn ngữ thao tác dữ liệu 
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Bài tập và thực hành 1                   TÌM HIỂU HỆ CƠ SỞ DỮ LIỆU 

1. Mục đích, yêu cầu 
- Biết một số công việc cơ bản khi xây dựng một cơ sở dữ liệu đơn giản 

2. Nội dung 
Bài 1: Tìm hiểu nội quy của thư viện, thẻ thư viện, phiếu mượn/trả sách, sổ quản lí sách,… 

của thư viện trường THPT 

+ Nội quy thư viện 

- Mượn sách phải có thẻ 

-  Mượn trả sách đúng quy định 

-  Sau khi trả sách cũ mới được mượn sách mới 

-  Làm hỏng, mất sách phải đền bù theo giá sách 

-  Vào thư viện không được đùa nghịch 

-  Không được tự ý lấy sách khi chưa được phép 

+ Thẻ thư viện: Bao gồm các thông tin: 

- Ảnh 

- Số thẻ 

- Họ và tên 

- Lớp 

- Năm học 

- Địa chỉ 

   + Phiếu mượn trả sách: Bao gồm: 

- STT 

- Tên sách 

- Ngày mượn 

- Ngày trả 

- Số sách mượn 

Bài 2: Kể tên các hoạt động chính của thư viện 
- Cấp thẻ thư viện 

- Mua, nhập và thanh lí sách 

- Cho mượn sách 

- Giới thiệu sách 

- Trao đổi sách 

- Đọc sách tại chỗ 

- Giải quyết các sự cố vi phạm nội quy của thư viện 
Bài toán 3: Hãy liệt kê các đối tượng cần quản lí khi xây dựng CSDL quản lí sách và mượn/trả sách. 

Với mỗi đối tượng, hãy liệt kê các thông tin cần quản lí. 

Stt Đối tượng Thông tin về đối tượng 

1 Người mượn -         Số thẻ 

-         Họ và tên 

-         Ngày sinh 

-         Giới tính 

-         Lớp 

-         Địa chỉ 

-         Ngày cấp thẻ 

-         Ghi chú 

2 Sách -         Mã sách 

-         Tên sách 

-         Loại sách 

-         Nhà xuất bản 

-         Năm xuất bản 

-         Giá tiền 

-         Mã tác giả 

-         Tóm tắt nội dung sách 



TRƯỜNG THPT HỒ THỊ BI  TÀI LIỆU TIN HỌC 12 

8 

 

3 Tác giả -         Mã tác giả 

-         Họ và tên tác giả 

-         Ngày sinh 

-         Ngày mất (nếu có) 

-         Tóm tắt tiểu sử 

4 Phiếu mượn -         Mã thẻ 

-         Họ tên 

-         Ngày nượn 

-         Ngày trả 

-         Mã sách 

-         Số lượng sách mượn 

5 Trả sách -         Số phiếu mượn 

-         Ngày trả 

-         Số biên bản ghi sự cố (nếu có) 

6 Hóa đơn -         Số hóa đơn nhập sách 

-         Mã sách 

-         Số lượng nhập 

7 Thanh lí -         Số hiệu biên bản thanh lí 

-         Mã sách 

-         Số lượng thanh lí 

8 Đền bù -         Số hiệu biên bản đền bù 

-         Mã sách 

-         Số lượng đền bù 

-         Tiền đền bù (nếu có) 

……. ……..           ………………….. 

Bài 4: Theo em, CSDL nêu trên cần những bảng nào? Mỗi bảng cần có những cột nào? 

 Bảng TACGIA (thông tin về tác giả) 

MaTG 
(Mã tác giả) 

HoTen 
(Họ và tên) 

NGSinh 
(Ngày sinh) 

NgMat 
(Ngày mất, nếu có) 

TieuSu 
(Tóm tắt tiểu sử) 

 

 Bảng SACH (thông tin về sách) 

MaSach TenSach LoaiSach NXB NamXB GiaTien MaTG NoiDung 

 

 Bảng HOCSINH (thông tin về độc giả) 

MaThe HoTen NgSinh GioiTinh Lop NgayCap DiaChi 

 

 Bảng PHIEUMUON (quản lí việc mượn sách) 

MaThe SoPhieu NgayMuon NgayTra MaSach SLM 

 

 Bảng TRASACH (quản lí việc trả sách) 

SoPhieu 
(Số phiếu mượn) 

NgayTra 
(Ngày trả sách) 

SoBB 
(Số biên bản ghi sự cố) 

 

 Bảng HOADON (quản lí các hóa đơn nhập sách) 

So_HD 
(Số hiệu hóa đơn nhập sách) 

MaSach 
(Mã sách) 

SLNhap 
(Số lượng nhập) 

 

 Bảng THANHLI (quản lí các biên bản thanh lí sách) 

 So_BBTL 
(Số biên bản thanh lí) 

MaSach 
(Mã sách) 

SLTL 
(Số lượng thanh lí) 

 

 Bảng DENBU (quản lí các biên bản về sự cố mất sách, đền bù sách và tiền) 

So_BBDB 
(Số hiệu biên bản đền bù) 

MaSach 
(Mã sách) 

SLDenBu 
(Số lượng đền bù) 

TienDenBu 
(Số tiền đền bù) 
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  Chương II:  HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU MICROSOFT ACCESS 

Bài 3. GIỚI THIỆU MICROSOFT ACCESS 

1. Phần mềm Microsoft Access(gọi tắt là Access) 

- Là hệ quản trị cơ sở dữ liệu nằm trong bộ phần mềm Microsoft Office của hãng Microsoft 

dành cho máy tính cá nhân và máy tính chạy trong mạng cục bộ. 

2. Khả năng của Access 

a) Access có những khả năng nào?  

- Cung cấp các công cụ khai báo, lưu trữ và xử lí dữ liệu như: 

+ Tạo các bảng chứa dữ liệu và mối liên kết giữa các bảng đó. 

+ Tạo biểu mẫu để cập nhật dữ liệu, tạo báo các tống kê, tổng kết hay mẫu hỏi để khai 

thác dữ liệu trong CSDL. 

b) Ví dụ : Có thể dùng Access xây dựng CSDL "Quản lí học sinh" giúp giáo viên quản lí học 

sinh lớp mình, cập nhật thông tin, tính điểm trung bình môn, tính toán và thống kê một cách tự 

động. 

3. Các loại đối tượng chính của Access 

a) Các loại đối tượng 

 Bảng (table) Là đối tượng duy nhất dùng để lưu dữ liệu và phải được tạo lập đầu tiên. 

Mỗi bảng chứa thông tin về một chủ thể xác định và bao gồm nhiều hàng, mỗi hàng chứa các 

thông tin về một cá thể xác định của chủ thể đó. 

 Mẫu hỏi (query) dùngđể sắp xếp, tìm kiếm và kết xuất dữ liệu xác định từ một hoặc nhiều 

bảng.  

 Biểu mẫu (form) giúp cho việcnhập hoặc hiển thị thông tin một cách thuận tiện. 

 Báo cáo (report) được thiết kế để định dạng, tính toán, tổng hợp các dữ liệu được chọn và 

in ra. 

b) Ví dụ 

Dùng Access để xây dựng CSDL quản lý học sinh → CSDL này có thể gồm: 

- Bảng HỌC_SINH 

Họ và tên Ngày sinh Giới tính Địa chỉ Đoàn viên Tổ Toán Lí … Hóa Văn Tin 

            

- Một số biểu mẫu:  Nhap_LL_HS ( Dùng để nhập lí lích học sinh) 

 Nhap_diem ( Dùng để giáo viên nhập điểm) 

- Một số mẫu hỏi: Dùng để xem thông tin theo Tổ hay tính toán điểm TB 

- Một số báo cáo: Xem và in bảng điểm theo môn học, danh sách đoàn viên, thống kê điểm số ... 

4. Một số thao tác cơ bản 

a) Khởi động Access 

 Cách 1: chọn Start → All Programs → Microsoft Access2013 

 Cách 2: Nháy đúp vào biểu tượng Access    trên màn hình nền. 
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Khi khởi động Access, trong cửa sổ khởi động, mặc định tab File và lệnh New trong tab File 

được chọn, cửa sổ được chia thành 2 khung như hình sau: 

 

 

 

b) Tạo CSDL mới: 

❖ Khi khởi động Access 

- Trong cửa sổ hình trên nhấp chọn:  

- Xuất  hiện cửa sổ: 

 

 

 

 

 

 

 

 

 

 

 

 

 

❖ Khi đang trong cửa sổ làm việc của Access: 

Từ File→New→Blank Database→Nhập tên CSDL ở hộp File Name → nhấp  

(để chọn vị trí lưu)  → Sau đó nháy và nút Create để xác nhận tạo tệp CSDL mới. 

• Tệp CSDL vừa tạo chưa có đối tượng nào (CSDL trống). 

• Khi CSDL đã có các bảng dữ liệu thì các bảng đó sẽ xuất hiện trên trang bảng. 

c) Mở CSDL đã có 

 Cách 1: Nháy chuột lên tên của CSDL (nếu có) trong thẻ File. 

 Cách 2: Chọn lệnh File→Open... rồi tìm và nháy đúp vào tên CSDL cần mở.  

Chú ý  

 Tại mỗi thời điểm, Access chỉ làm việc với một CSDL.   

Danh sách các file mới mở gần đây. Các loại tập tin cơ sở dữ liệu có thể tạo mới 

Nhập tên CSDL tại đây 

Click đây để thay đổi nơi lưu trữ 

Đường dẫn chỉ nơi lưu trữ tập tin CSDL 

Nút xác nhận tạo tệp CSDL mới 
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 Access tạo ra một tệp duy nhất thường có phần mở rộng là .accdb chứa tất cả các đối 

tượng liên quan đến một CSDL: bảng, biểu mẫu, mẫu hỏi, báo cáo,… Do vậy người ta 

cũng thường gọi tệp CSDL thay cho CSDL. 

d) Kết thúc phiên làm việc với Access 

 Cách 1: Chọn File→Exit hoặc nhấn tổ hợp phím Alt+F4. 

 Cách 2: Nháy nút  ở góc trên bên phải màn hình làm việc của Access.  

5. Làm việc với các đối tượng 

a) Chế độ làm việc với các đối tượng (trong thẻ Home)  

 Chế độ thiết kế (Design View)dùng để tạo mới hoặc thay đổi cấu trúc bảng, mẫu hỏi, thay 

đổi cách trình bày và định dạng biểu mẫu, báo cáo. 

Để chọn chế độ thiết kế, nháy nút Design View .  

 

 Chế độ trang dữ liệu (Datasheet View)dùng để hiển thị dữ liệu dạng bảng, cho phép xem, 

xoá hoặc thay đổi các dữ liệu đã có.  

Để chọn chế độ trang dữ liệu, nháy nút Datasheet View.  

Riêng đối tượng Form không có chế độ Datasheet View mà thay vào đó là 2 chế độ Layout View 

và Form View 

b) Tạo đối tượng mới 

− Click tab Create trên thanh Ribbon.  

 

− Trong nhóm công cụ của từng đối tượng, có thể chọn cách tạo tương ứngví dụ như:  

 Dùng các mẫu dựng sẵn (wizard)-thuật sĩ 

 Người dùng tự thiết kế (Design) 

c) Mở đối tượng 

Trong cửa sổ của loại đối tượng tương ứng, nháy đúp lên tên một đối tượng để mở nó.  

Ví dụ, nháy đúp lên tên bảng HOC_SINHđể mở bảng này. 

Củng cố: 

Hãy chọn các chức năng chính tương ứng với từng đối tượng trong danh sách chức năng và đối tượng 

sau: 

Đối tượng Chức năng 

a) Bảng 

b) Mẫu hỏi 

c) Biểu mẫu 

d) Báo cáo 

1) Giúp nhập thông tin thuận tiện. 

2) Lưu dữ liệu. 

3) Kết xuất thông tin từ bảng và mẫu hỏi. 

4) Là đối tượng cơ sở chứa thông tin về một chủ thể xác định. 

5) Tạo bảng mới từ các bảng đã có. 

6) Giúp hiển thị thông tin thuận tiện. 

7) Định dạng, tính toán, tổng hợp các dữ liệu được chọn và in ra. 
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BÀI 4: CẤU TRÚC BẢNG   

1. Các khái niệm 

Bảng ở chế độ trang dữ liệu (datasheet View) 

 

Bảng ở chế độ thiết kế (Design view)  

 

* Table (bảng) 

 Bảnggồm: 

•Các cột 

•Các hàng 

•chứa toàn bộ dữ liệu 

 

* Trường (field):Mỗi trường là một cột của bảng thể hiện một thuộc tính của đối tượngcần quản 

lí. 

Ví dụ, trong bảng HOC_SINH có các trường: Ten, NgSinh, DiaChi, GT,… 

* Bản ghi (record): Mỗi bản ghi là một hàng của bảng gồm dữ liệu về các thuộc tính của chủ 

thể được quản lí. 

Ví dụ, trong bảng HOC_SINH bản ghi thứ 5 có bộ dữ liệu là:  

{5, Phạm Kim, Anh, Nữ, 5/12/1991, không là đoàn viên, 12 Lê Lợi, 2}. 

Cấu trúc 

 

Dữ liệu 

Dữ liệu  

tạo nên CSDL 
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* Kiểu dữ liệu (Data Type): Là kiểu của dữ liệu lưu trong một trường. Mỗi trường có một kiểu 

dữ liệu.  

Dưới đây là một số kiểu dữ liệu chính trong Access 2013 

Kiểu dữ liệu Mô tả Kích thước lưu trữ 

Text Dữ liệu kiểu văn bản gồm các kí tự 0-255 kí tự 

Memo Dữ liệu kiểu văn bản 0-63999 kí tự 

Number Dữ liệu kiểu số 1, 2, 4, 8 hoặc 16 byte 

Date/Time Dữ liệu kiểu ngày / giờ 8 byte 

Currency Dữ liệu kiểu tiền tệ 8 byte 

AutoNumber 
Dữ liệu kiểu số đếm, tăng tự động cho bản 

ghi mới và thường có bước tăng là 1  

4 hoặc 16 byte 

Yes/No Dữ liệu kiểu Boolean (hay Lôgic) 1 bit 

OLE Object 
Lưu ảnh, âm thanh, biểu đồ… Lên tới 1 gigabyte (giới hạn bởi 

không gian đĩa có sẵn) 

Hyperlink 
Đường dẫn đến một đích đến như một đối 

tượng, tài liệu, hoặc trang Web 

Có thể chứa đến 2048 ký tự 

attachments File đính kèm  

Lookup Wizard Thiết lập kiểu dữ liệu được chọn 4 byte 

Vận dụng:Trong mô tả dữ liệu quản lý vận động viên của  một trung tâm TDTT sau hãy chọn các 

kiểu dữ liệu thích hợp cho các trường từ các kiểu dữ liệu sau: text, Memo, number, date/time, 

currency,  autoNumber, Yes/No, OLEObject 

VAN_DONG_VIEN 
autoNumber text         

Kiểu dữ liệu 

MaSo Ten Ngsinh GT DiaChi Hinh Do-

anV 

Luong HeSo Tom-

TatTT 

1 An 01/01/1994 Nam TP.HCM   4.500.000đ 2.3 …. 

… … … … … … … … … … 

 

 

* Các thuộc tính của Field 

- Field Size: kích thước field. Ý nghĩa thay đổi theo kiểu dữ liệu. 

 + text: độ dài của xâu (tối đa 255, mặc định là 255) 

 + number:Chọn kiểu với kích thước thích hợp: byte (1byte), integer (2b), long Integer (4b), 

decimal (12b), single (4b),double (8b); Replication ID (16b) 

- Format:Định dạng dữ liệu như date/time(dd/mm/yyyy hoặc short date…) 

(Trong HĐH Windows để định dạng ngày giờ hệ thống: 

 Start/Control Panel/Clock, Language, and Region/ RegionandLanguage 

- Decimal places: số chữ số thập phân của dữ liệu kiểu number 

- Input mask: Qui định mẫu (mặt nạ) nhập dữ liệu 

0: một ký tự số từ 0 → 9 (bắt buộc nhập) 

9:một ký tự số từ 0 → 9 (không bắt buộc nhập) 

Ví dụ: Một trường bắt buộc phải nhập đủ 3 chữ số phần nguyên và 2 chữ số phần thập phân 

thì mặt lạ nhập có dạng 000.00 

- Default value: Giá trị cho trước 

- Validation Rule: Biểu thức chỉ qui tắc kiểm tra giá trị nhập ( VD:  <= 10 ) 

- Validation Text: Dòng thông báo khi dữ liệu nhập sai qui tắc. (VD: Điểm trung bình phải 

<=10) 

Bảng (Table) 

Trường (Field) 

 
Bản ghi (Record) 
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Vận dụng: Cho cơ sở dữ liệu như bảng dưới, ghép cột cho đúng: 

Bảng HOC_SINH 

MaSo HoDem Ten Ngsinh GT DiaChi Toan Li Hoa Van Tin 

1 Nguyễn An 01/01/1994 Nam TP.HCM 5.6 6.7 5.0 5.0 8.5 

…  … … … … .. .. .. .. .. 

Field Field properties 

1. STT b  

2. Ten d   

3. Ngsinh f  

4. GT  e  

5. Diachi  c  

6. Toan a,g,h,i,j,k 

7. Li ||  

8. Hoa ||  

9. Van ||  

10. Tin ||  

a. field size: Decimal 

b. field size : byte 

c.field size: 50 

d. field size: 10 

e. field size: 3 

f. format: dd/mm/yyyy 

g. decimal places:1 

h. Input mask: 99.9 

i. Default value: 0 

j. Validation Rule: <= 10 

k. Validation Text: Điểm phải <=10 

* Khóa chính (Primary Key): Khóa chính có tác dụng phân biệt giá trị các bản ghi trong cùng một 

bảng với nhau. Khóa chính có thể chỉ 01 trường, cũng có thể được tạo từ tập hợp nhiều trường. 

Vận dụng: Hãy chọn khoá chính cho các bảng sau bằng cách gạch chân trường làm khoá chính 

KHACH_HANG: (MaKH, TenKH, Dia_Chi, Dien_thoai) 

BAO: (MaBao, Ten_Bao, Gia_tien) 

CHUYEN_BAO: (Mabao, MaKH, Ngay, SoLuong) 

2. Tạo và sửa cấu trúc bảng 

a. Tạo cấu trúc bảng 

Bước 1: Trong cửa sổ làm việc của Access, trên thanh Ribbon, click Create, trong nhóm lệnh 

Table, click Table Design. 

Bước 2: Trong cửa sổ thiết kế: 

-    Cột Field Name: Nhập tên field. 

-    Cột Data Type: Chọn kiểu dữ liệu của Field tương ứng. 

-    Cột Description: Dùng để chú thích ý nghĩa của Field. 

-    Vùng Field Properties: Thiết lập các thuộc tính của Field, gồm có hai nhóm: 

o   General: là phần định dạng dữ liệu cho Field trong cột Field name 

o   Lookup: Là phần quy định dạng hiển thị /Nhập dữ liệu cho Field 

Bước 3: Xác định khóa chính (Primary Key) cho bảng. 

-    Đặt con trỏ tại Field được chọn→ click vào biểu tượng Primary Key 

Bước 4: Nhấn Ctrl + S để lưu bảng vừa tạo. 

-    Nhập tên bảng vào hộp thoại Save As →Click OK 

 
Chọn tab Create → Table Design 

Nhập tên 

field 

Chọn kiểu  

dữ liệu Chú thích 
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b. Sửa cấu trúc bảng (ở chế độ thiết kế Design View) 

 Trường  

 Thay đổi thứ tự trường: Kéo thả chuột 

 Thêm trường:  

 Xóa trường: 

   Thay đổi khóa chính:Chọn trường muốn đổi rồi Nhắp chọn → 

   Thay đổi tên bảng: Đóng bảng, nhắp phải tại tên bảng chọn Rename rồi gõ tên mới. 

   Xóa bảng: Đóng bảng, chọn bảng muốn xóa rối nhấn Delete trên bàn phím hoặc nhấn 

vùng Records  của tab Home. 

 

Vídụ chọn thuộc tính 

cho trườngđiểmToan 
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Bài tập và thực hành 2 

TẠO CẤU TRÚC BẢNG 
Bài 1: 

Yêu cầu 1: Tạo thư mục tên lớp trong ổ đĩa D. Ví dụ : A3 

Yêu cầu 2: Khởi động Access→ Tạo CSDL có tên QL_HOC_SINHtrong thư mục lớpnhư sau: 

 
 

→ Một CSDL trống với tên QL_HOC_SINH vừa được tạo. 

Yêu cầu 3: Tạo bảng HOC_SINH: 

Trên thanh Ribbon chọn thẻ Create → trong vùng Tables nhất nút  

 

→ Xuất hiện bảng hội thoại sau: 

 
→ Tiến hành nhập tên trường ở cột Field Name , chọn kiểu dữ liệu ở cột Data Type, nhập 

mô tả ở cột Description,đặt thuộc tính cho các trường ở vùng General và Lookup. 

→ Nhập các trường của bảng HOC_SINH như sau: 
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Chú ý: Đối với các trường điểm trung bình môn, để nhập được số thập phân có một chữ số 

và luôn hiển thị dạng thập phân, ta cần một số tính chất của trường này như hình bên: 

 
Lưu ýcác trường điểm số môn Toan, Ly, Hoa, Van, Tin có các thuộc tính như nhau→ tạo 

trường Toan với các thuộc tính như hình trang .... → Sau đó copy và đổi tên thành Ly, Hoa, 

Van, Tin 

 

Bài 2: Chỉ định khóa chính: Chỉ định trường Maso là khóa chính. 

Các thao tác thực hiện: 

• Bước 1. Chọn trường Maso làm khóa chính; 

• Bước 2. Nháy nút   hoặc click chuột phải chọn Primary key 

 

Bài 3: 

- Chuyển trường DoanVien xuống trường NgSinh và trên trường Diachi: 

• Bước 1. Chọn trường NgSinh; 

• Bước 2. Nhấn giữ và kéo thả chuột lên trên trường DoanVien; 

- Thêm các trường Li, Hoa và Tin: 
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+ Bước 1. Click chuột phải, chọn Insert → Rows; 

+ Bước 2. Nhập các thông số: 

- Tên trường vào cột Field Name; 

- Chọn kiểu dữ liệu trong cột Data Type; 

- Mô tả nội dung trường trong cột Description (không bắt buộc)  

- Lựa chọn tính chất của trường trong phần Field Properties. 

 

- Di chuyển các trường: Nhấn giữ và kéo thả chuột. 

- Lưu lại bảng: Chọn File chọn Save hoặc nháy chọn nút lệnh ; 

- Thoát khỏi Access: Chọn File →Close. Hoặc nháy lên nút Close ở góc trên phải cửa sổ màn hình 

Access. 

Một số lưu ý: 

❖ Đặt tên trong Access: 

− Không đặt tên bảng hay mẫu hỏi trùng tên. 

− Tên trường <= 64 kí tự. 

− Những kí tự không dùng trong tên đối tượng gồm dấu chấm, phẩy, chấm than, huyền, [ ] . 

− Tránh tên trùng với tên hàm có sẵn trong access hoặc tên các thuộc tính của trường. 

❖ Trong chế độ thiết kế để tạo/sửa cấu trúc bảng: 

- Nhấn phím Tab hoặc Enter để chuyển qua lại giữa các ô . 

- Nhấn phím F6 để chuyển qua lại giữa 2 phần của cửa sổ cấu trúc bảng. 

- Để chọn một trường, ta nháy chuột vào ô bên trái tên trường (con trỏ chuột có hình mũi tên), 

khi được chọn, toàn bộ dòng định nghĩa trường được bôi đen. 

- Khi đã chỉ định khóa chính cho bảng, không được nhập giá trị trùng hoặc để trống giá trị trong 

trường khoá chính . 

 
 

 


